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Additive Manufacturing Tutorials



What You Need to Know About AM Tutorials
These tutorial problems demonstrate how to use some of the features in the Ansys family of products
dedicated to Additive Manufacturing. Each tutorial is a complete step-by-step simulation procedure.

The tutorials in this document were run on a 64-bit Windows 10 system. Your results may vary depending
upon your computer hardware and operating system.

Use the link provided under Tutorial Files in the problem description of each tutorial to obtain the
file(s) required to run the tutorial.
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Chapter 1: Calibration - Double Arches Geometry
This example demonstrates the workflow for an additive calibration using an LPBF Thermal-Structural
simulation in Mechanical. The Thermal Strain Scaling Factor (TSSF) is obtained from this calibration
process for an AM build using Inconel 718 material.

The following features and capabilities are used:

• Thermal-structural simulation

• LPBF Process Add-on

• LPBF Setup Wizard

• Geometry construction of base plate

• Cartesian mesh

• Direct optimization module to perform the calibration iterations

Tutorial steps:

1.1. Problem Description

1.2. Create the Analysis System

1.3. Import Geometry and Launch Mechanical

1.4. Set Units and Load the LPBF Process Add-on

1.5.Wizard Step 1 - Identify Geometries

1.6.Wizard Step 2 - Generate Mesh

1.7.Wizard Step 3 - Assign Materials

1.8.Wizard Step 4 - Define Build Settings

1.9.Wizard Step 5 - Define Boundary Conditions and Constraints

1.10.Wizard Step 6 - Set Up Calibration

1.11. Run Calibration Iterations

1.12. Obtain the Optimum Calibration TSSF

1.1. Problem Description

This example part is used to demonstrate the overall calibration process using the LPBF Setup Wizard
in Mechanical. You may want to design/choose the most appropriate calibration geometry for your
own scenario by referring to Performing a Calibration in the LPBF Simulation Guide.

The double arches geometry is shown in the following schematic. This part's overall dimensions are 45
mm by 10 mm by 28 mm in the X, Y, and Z directions, respectively. The part is designed so that the

1
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major distortion can be measured near the region of change in cross-sectional area at Z=21 mm, as
indicated by the red arrow. Following fabrication, the as-built on-plate distortion of the part is measured
along the center line of the side edge, as highlighted by the red dashed line in the second figure. This
measurement line has coordinates X=0 and Y=5 mm. The image depicts an as-built calibration part on
the plate after fabrication.
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The calibration part was fabricated using a laser powder bed fusion process with the machine process
parameter set as shown in the following table. Some of these processing parameters are used as inputs
in the simulation. The part was built with Inconel 718 material directly on a build plate with no support
structures.

Ti-6Al-4V Processing Parameters

60Layer Thickness (µm)

200Preheat Temperature (°C)
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Ti-6Al-4V Processing Parameters

ArInert gas

85Beam Diameter (µm)

350Laser Power (W)

800Laser Speed (mm/s)

0.12Hatch Distance (mm)

10Stripe Length (mm)

45Starting Angle (°)

67Rotation Angle (°)

61Energy Density (J/mm3)

The maximum as-built on-plate distortion for this build was 0.449 mm in shrinkage near Z = 21 mm
located along the measurement line shown in the figures. This distortion value will be used as the target
value for the simulation.

Tutorial Files

Click here to download:

Double_arches_p.stl — Geometry file of the double arches calibration part, saved as an .stl doc-
ument. There are no supports for this model.

1.2. Create the Analysis System

1. Open Ansys Workbench.

2. In the toolbox on the left side of the window, scroll down to Custom Systems, expand the se-
lection, and double-click AM LPBF Thermal-Structural to bring up the linked Transient Thermal,
Static Structural system in the Project Schematic.
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1.3. Import Geometry and Launch Mechanical

In this step, we import the geometry file in Workbench and then open the Mechanical application.

1. Right-click the Geometry cell in the Transient Thermal system and select Import Geometry >
Browse.

2. Navigate to the double arches geometry file, select it, and click Open to add it to the analysis.
A green checkmark appears next to the Geometry cell in the Project Schematic when the geo-
metry is added.
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3. Double-click the Model cell in the Transient Thermal system to launch the Mechanical application.
A message "Starting Mechanical" appears in the status bar in the bottom, left corner. It may
take a few moments for the application to open and the geometry to appear.
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1.4. Set Units and Load the LPBF Process Add-on

In this step, we do a few things to set up for the simulation. Use your mouse buttons to pan, zoom,
and rotate the model as you wish.

1. First, set the units to millimeters. In the bottom, right corner of the application UI, select the
little up arrow to expand the units options and choose Metric (mm, kg, N, s, mV, mA).
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2. Next, adjust the number of processors (cores) to use on your computer. Depending on the
complexity of your model, AM Process Simulations may be computer intensive. If you have an
Ansys HPC license, access the option from the Home tab, under the Solve group and change
the Cores to something appropriate for your simulation.

3. Next we'll load the LPBF Process Add-on. This add-on is available only if you have an Ansys
Additive Suite software license with Ansys Mechanical Enterprise or one of the multiphysics
bundles. If LPBF Process appears grayed out, or does not appear in the Add-ons ribbon as
shown below, check your software license.

Click the Add-ons tab in the main menu. In the Add-ons ribbon, click LPBF Process.

4. The remainder of the set-up is done using the LPBF Setup Wizard. Click the LPBF Process tab
and then click LPBF Setup Wizard to open the wizard.
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Note:

You may be wondering why we chose the LPBF Setup Wizard rather than the LPBF Calibration
Wizard. Use the former when setting up a simulation for the first time, as we are doing in
this tutorial. Use the latter when you already have a simulation solved and you simply need
to add on a calibration step.

1.5. Wizard Step 1 - Identify Geometries

This step is to identify which body is the part, the base, and the supports. For this tutorial, there are no
supports and we will create a base plate using construction geometry.

1. Select the arches body and click Apply in the Part Selection field. (Note the Body picker  is
active by default.)

2. Under Support Geometry, choose No Supports because there are no supports for this model.

3. For the Base Geometry field, choose Create Base because there is no base plate included in
our geometry file. We will define X, Y, and Z dimensions of the base and the X, Y, and Z location
of the center of the top surface of the base.

4. Enter 60 for Length (x).

5. Enter 35 for Width (y).

6. Enter 10 for Thickness (z).

7. Enter 22.5 for X-Location.

8. Enter 5 for Y-Location.

9. Enter 0 for Z-Location.

10. Leave the remaining options set to the default of No and click Next at the bottom of the wizard
page.
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Notice that items are added and/or updated in the project tree after each step in the wizard. It is a
good idea to review these items that have changed corresponding to the actions in the wizard as this
is a good way to learn about Ansys Mechanical.

1.6. Wizard Step 2 - Generate Mesh

In this step, set mesh controls and generate the mesh. We will use a Cartesian mesh with the recom-
mended element size of 0.5 mm for this part.

1. Under Mesh Type, choose Cartesian.

2. For Build Element Size, enter 0.5 to define a mesh size of 0.5 millimeters.

Keep 0 (default) for Projection Factor.

3. For Base Element Size, enter 2 to allow a much coarser mesh size.

4. Leave the remaining options set to the default of Yes and click Next to move to the next step.
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1.7. Wizard Step 3 - Assign Materials

In this step, assign materials to the build and the base.

1. Under Build Material, choose Inconel 718.

2. Under Base Material, choose Inconel 718.

By default, bilinear isotropic hardening material properties are applied to the model when a
material with those properties is applied. You can confirm this by viewing that Nonlinear Effects
is set to Yes for both the part and the base. (In the project tree on the left side of the UI, expand
the Geometry object so you see the two bodies. Select each body and review the Details panel
for each at the bottom of the tree.)

3. Click Next.
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1.8. Wizard Step 4 - Define Build Settings

In this step, define machine settings, build conditions, and cooldown conditions.

Under Machine Settings:

1. Set Deposition Thickness to 0.06 mm. (This corresponds to the Layer Thickness of 60 µm.)

2. Set Hatch Spacing to 0.12 mm.

3. Set Laser Speed to 800 mm/s.

Under Build Conditions:

4. Set Preheat Temperature to 200 °C.

5. Leave the remaining settings to their defaults. Note that this includes removal settings. (Scroll
down in the wizard panel to see all the options.) We will not simulate cut-off of the part from
the base, as distortion measurements were taken on-plate in the experimental portion of the
calibration. Click Next.
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1.9. Wizard Step 5 - Define Boundary Conditions and Constraints

In this step, apply boundary conditions to the base. This includes a constant preheat temperature during
the build, an ambient cooldown temperature during cooldown, and a fixed condition throughout the
simulation because we assume the base is rigid with no distortion.

Under Base Thermal Boundary Conditions:

1. Select the bottom face of the base. Click Apply next to the Geometry input field.

2. Keeping Temperature as the Build Condition, enter 200 °C for Build Boundary Temperature.
Leave the default Cooldown condition as a 22 °C temperature.

Under Base Structural Boundary Condition:

3. Select the bottom face of the base again and click Apply as the geometry for the fixed support.

4. Click Next.
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1.10. Wizard Step 6 - Set Up Calibration

In this step, we establish a line of nodes for distortion measurements (similar to the red dashed line in
the experiments), enter our distortion target, and finish setting up for the calibration iterations. The
measurement line is along the Z axis located at X=0 and Y=5 mm.

1. First, we need to define a line of nodes and create a named selection for it. This is done outside
of the LPBF Setup Wizard but keep the wizard open. In the project tree, right-click Named Se-
lection and choose Insert > Named Selection. Rename the new Named Selection object to
MeasuredLine.

In the Details panel of MeasuredLine, change the Scoping Method to Worksheet.

Right-click in the Worksheet area and choose Add to add a new row. Set up the fields in the
new row as shown in the following figure. Then add a new Filter row and set up the fields as
shown. Click Generate. A line of highlighted nodes is shown on the vertical wall of the pillar.

2. Back in the wizard, choose Yes for Setup Calibration.

3. Under Measurement Location, change the Scoping Method to Named Selection. Choose the
MeasuredLine named selection. Choose X for Distortion Direction and enter 0.449 mm for
Target Distortion, which is our maximum distortion according to the experimental measurements.

4. Click Finish. Finally, click the x in the upper, right corner to exit the wizard panel. The calibration
simulation has now been set up successfully.
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1.11. Run Calibration Iterations

In this step, we run the calibration iterations using the automated Direct Optimization system in
Workbench.

1. Go back to the Workbench UI. After completion of the calibration setup in the LPBF Setup
Wizard, notice that the Direct Optimization system is automatically connected to the AM Thermal-
Structural Analysis systems. In the Direct Optimization system, right-click Optimization > Update
to start the calibration iterations. The optimization process will run the thermal-structural sim-
ulations iteratively by automatically applying different TSSF values starting from the default of
1 in order to search for the maximum distortion value along the defined MeasuredLine that
best matches the experimental distortion value. The simulations may take a few hours to
complete depending on the number of cores specified and the machine used to run this
model.
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1.12. Obtain the Optimum Calibration TSSF

1. Double-click the Optimization cell to open the Direct Optimization module.

2. Green check marks are shown under Results on the left hand side of the menu when the op-
timization is done. The last row shows the optimized calibration TSSF. In our example, the cal-
ibrated TSSF is 0.767, which results in a distortion of 0.4517 mm. This is within our 1% tolerance.
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Congratulations! You have completed the tutorial.
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Chapter 2: Additive Print Calibration - 4 Pillars
Geometry
This example demonstrates the workflow of performing an Assumed Strain, Linear Elastic calibration
simulation in Ansys Additive. The strain scaling factor (SSF) is obtained from this calibration process for
an AM build using Ti-6Al-4V alloy.

The following features and capabilities are used:

• Assumed Strain simulation type

• Ti64 material, Linear Elastic stress mode

• Calibration spreadsheet

Tutorial steps:

2.1. Problem Description

2.2. Import Geometry

2.3. Set Up Simulation

2.4. Select Geometry and Supports

2.5. Configure Materials

2.6. Select Outputs and Solve

2.7. Obtain the Distortion

2.8. Use Calibration Spreadsheet

2.9. Run Subsequent Calibration Iterations

2.10. Save Calibrated Material

2.1. Problem Description

This example part is used to demonstrate the overall calibration process in Ansys Additive. You may
want to design/choose the most appropriate calibration geometry for your own scenario by referring
to Determine Your Calibration Part in the Additive Print and Science Calibration Guide.

The 4-pillars geometry is a simple, symmetrical geometry with four 2-mm thick rectangular pillars attached
to a center cross beam. The overall dimensions of this part are 20 mm by 20 mm by 25 mm along the
X, Y, and Z directions respectively. The part is designed in such a way that a major distortion can be
measured near the overhang interface at Z=20 mm, as shown at the red arrow in the following
schematic. After fabrication, the on-plate distortion of the part in the as-built condition is measured
along the center line of the left pillar as highlighted by the purple dashed line. This measurement line
is located at X=0 and Y=5 mm. The picture shows the actual as-built calibration part example on plate
after fabrication.
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The calibration part was fabricated using a laser powder bed fusion process with the machine process
parameter set as shown in the following table. Some of these processing parameters are used as inputs
in the simulation. The part was built with Ti-6Al-4V material directly on a build plate with no support
structures.

Ti-6Al-4V Processing Parameters

60Layer Thickness (µm)

200Preheat Temperature (°C)

ArInert gas

85Beam Diameter (µm)

350Laser Power (W)

1100Laser Speed (mm/s)

0.12Hatch Distance (mm)

10Stripe Length (mm)

45Starting Angle (°)

67Rotation Angle (°)

44Energy Density (J/mm3)

The maximum as-built on-plate distortion for this build was 0.242 mm in shrinkage near Z = 20 mm
located along the measurement line shown in the schematic, at coordinates (0,10,20). This distortion
value will be used as the target value for the simulation.

Tutorial Files

Click here to download the following:

• 4_pillars.stl — Geometry file of the 4-pillars calibration part. There are no supports for
this model and a base plate is not needed in Ansys Additive.
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• Additive_Print_Calibration_Spreadsheet.xlxs — Custom spreadsheet with em-
bedded calibration calculations.

2.2. Import Geometry

1. Open Ansys Additive.

2. Click Parts to bring up the Parts Library.

3. When the Parts Library is loaded, click the Import Part button in the upper, right corner.

4. In the Import Part page, click Choose File and navigate to the 4_pillars.stl geometry,
select it, and click Open. Parts must be in .stl format and dimensions must be in units of milli-
meters. A green check mark appears on the page indicating a valid part has been chosen.

5. Enter a Name for the part and, optionally, tags and a description.

6. Click Save.
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The import operation occurs when we hit Save. It may take several minutes to import, depending
on the size of the part. The part is available to be used in a simulation when the availability
status says "Available" on the part's details page.

2.3. Set Up Simulation

1. Click Dashboard, and under New, choose Assumed Strain. This will bring up a new Assumed
Strain simulation form.
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2. Enter a Simulation Title and, optionally, tags and a description for the simulation. We have
found it is good practice to use a detailed description for record-keeping purposes. In this ex-
ample we added "1st iteration" to the description because we anticipate additional iterations
when performing a calibration.

3. Depending on your Additive license, change the Number of Cores, as desired.

2.4. Select Geometry and Supports

1. Scroll to the Geometry Selection section and choose the 4-pillars calibration part we just imported
and click Add.
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2. For Voxel Size, enter 0.5 to define a mesh size of 0.5 millimeters.

A voxel size of 0.5 mm for this geometry is larger than we recommend but is used here to speed up
the tutorial. A much smaller voxel size of 0.2 mm is more realistic for this geometry.
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3. Scroll to the Supports section and uncheck Simulate with Supports since there are no support
structures for this model.

2.5. Configure Materials

1. Scroll to the Material Configuration section and select Ti64 from the drop-down list.

2. Under Stress Mode, choose Linear Elastic.

3. Use the default Strain Scaling Factor of 1 for this first calibration iteration. We will be changing
this value for subsequent iterations.
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2.6. Select Outputs and Solve

1. We do not need to add any extra output items so we will simply use the default on-plate residual
stress/distortion results.

2. Click Start to begin the first calibration iteration.

While the simulation is running, review the activity status and logs for helpful information. The
Simulation ID is a unique identification number given to this one simulation. Output files will
include this ID in their file names.
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2.7. Obtain the Distortion

1. Once the simulation is complete, output files are available for review. First we'll look at the
results in the Additive application.

a. Click View next to On plate stress/displacement (avz) to bring up the viewer.
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b. The result item displayed by default is the total displacement vector. We need to change
the display so that we are looking at the X component of displacement. Click the View
Manager button in the viewer controls bar.
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c. In the View Manager drop-down, check the box next to disp_x and clear the disp check
box. Rotate the model so that the pillar with the greatest shrinkage distortion (red
contour) is shown. Move the mouse around within this area to see the X-displacement.
Click Close in the upper right corner to get back to the simulation results page.
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2. Since it is a bit tricky to find the maximum displacement and to know its exact location, we
will view the results in Ansys EnSight.

a. Start by exporting the results to a .vtk file. Click Export next to On plate stress/displace-
ment and then Save the file.
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b. Open Ansys EnSight.

c. Click File > Open, navigate to the simulation .vtk file and click OK.

d. Right-click the newly added sim file and choose Color by > Select variable. In the
dialog box that opens, click on the symbol to expand the Vectors options, choose
disp_mm_[X] and then click OK.
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e. Rotate the model so that the pillar with the greatest shrinkage distortion (red contour)

is shown. Click the Interactive probe query button  from the ribbon. A dialog
box opens. In the Probe create tab click the Show components check box and then
click disp_mm_[X] to display the X component of displacement.

In the lower half of the dialog box, from the Query drop-down, choose XYZ. Enter X,
Y, and Z values as 0, 10, and 20. Click Create. The node number and X-displacement
are shown.
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f. Next we will use the settings in the Display style tab to change how the probe is dis-
played. In the Probe query box, switch to the Display style tab and change the settings
as shown below. This removes the node ID number, changes the displacement value
to floating point format with 3 decimal places, and increases the size of the marker dot
that indicates the location.
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g. Finally, we want to probe nearby node locations in the Z direction to see if we observe
a higher displacement. Remember that the coordinates of (0,10,20) correspond to the
location of maximum distortion in the experimental portion of the calibration. In the
simulation the location of maximum distortion may shift a little bit since the element
size is larger than the layer thickness. At (0,10,20.5) the distortion value of 0.169 mm
is higher than at (0,10,20) so that is what we will use for the first calibration iteration.

2.8. Use Calibration Spreadsheet

A spreadsheet is used for the SSF calculations.

1. Open the Ansys Additive Calibration Sheet .xlxs file.

2. Click Calibration for AS tab.

3. Enter 0.242 mm as the experimental distortion target (measurement) in cell E5.

4. In the Linear Elastic table, record the simulation number, in our example it is 575, in cell D9
and then the distortion result 0.169 mm from the first calibration iteration in cell E9.

The calibration spreadsheet will automatically calculate a new SSF value for the next simulation
iteration, shown in both cell G9 and F10. At the same time, it will also calculate the % error
between the simulation and the experimental distortion value.
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2.9. Run Subsequent Calibration Iterations

Perform a new simulation with all inputs unchanged except for the new SSF value. To make it easy, use
the Duplicate button on the simulation results page to copy the first iteration to a new simulation
form. Then change the simulation description (to note 2nd iteration) and the SSF value and click Start.
Iterate until the calculated SSF converges to an acceptable level of error between measured and simu-
lated, or until the results will not get any better.

In our example, the best simulation result is achieved in the 2nd iteration with SSF = 1.432, which yields
a 0.0% error.
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2.10. Save Calibrated Material

In the Results Summary tab of the spreadsheet, record the calibrated SSF for future Assumed Strain,
Linear Elastic simulations in Ansys Additive using Ti-6Al-4V.

Within Additive Print, we recommend you save the final SSF by creating a customized "calibrated ma-
terial." In the Materials Library, select your original material and then click Customize. This brings up an
edit panel where you can change the title, description, and SSF value for your calibrated material. Then
be sure to select the appropriate custom material when performing future simulations.

Congratulations! You have completed the tutorial.
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Chapter 3: LPBF Simulation - Bracket
This tutorial demonstrates how to perform a laser powder bed fusion (LPBF) additive process simulation
in Mechanical using the LPBF Process Add-on. The following table shows the features used.

Workbench/Mechanical

An Additive Suite license is required in addition to the license for
Mechanical.

Applicable products:

EasyLevel of difficulty:

10 minutes to set up, 85 - 95 minutes to solve, 10 minutes to review

results[a]

Interactive time required:

Laser powder bed fusion (LPBF)Manufacturing process:

AM LPBF Thermal-StructuralSimulation/system type:

AlSi10MgMaterial:

One part and one volumeless STL SupportGeometry:

Part: Layered tetrahedral elements

Support: Voxel elements

Mesh:

1. Build and cooldown

2. Base unbolting

AM steps simulated:

3. Base removal

4. Support removal

LPBF Process Add-on, LPBF Setup Wizard[b], animation, section plane,
AM result items

Features demonstrated:

Using the LPBF Setup WizardHelp resources:

This is an approximate range. The amount of time it takes you to complete the tutorial
depends on the computer system and the number of CPU cores you use, the working pace
that is comfortable for you, and so on.

[a]

This tutorial demonstrates the default Windows-based wizard introduced in Release 2023
R2, which is incompatible with Linux. Instead, Linux users will use the Legacy LPBF Setup

[b]

Wizard, which is launched for Linux users by default. Although the GUI options and beha-
viors differ, Linux users should be able to follow along using the same engineering content.

Tutorial steps:

3.1. Problem Description

3.2. Create the Analysis System

3.3. Import Geometry and Launch Mechanical

3.4. Load the LPBF Process Add-on and Open the LPBF Setup Wizard
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3.5. Complete Wizard Step 1 - Model Setup

3.6. Complete Wizard Step 2 - Build Settings

3.7. Complete Wizard Step 3 - Postprocessing Options

3.8. Solve

3.9. Review Results

3.1. Problem Description

We will be simulating the additive manufacture of the bracket shown in the following figures. This
geometry is one that is typical of a part that has been light-weighted using topology optimization. The
first figure shows the part geometry and the second figure shows the part with its support on the ad-
ditive build plate. The build material is AlSi10Mg.
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Tutorial Files

Click here to download the following:

• bracket_on_base.scdoc - Geometry file of the bracket part and a base plate, saved as an
Ansys SpaceClaim document.

• bracket_support_vless.stl - Support structure for the bracket.

3.2. Create the Analysis System

1. Open Ansys Workbench.

2. In the Toolbox on the left side of the window, scroll down to Custom Systems, expand the se-
lection, and double-click AM LPBF Thermal-Structural to bring up the linked Transient Thermal,
Static Structural system in the Project Schematic. The Transient Thermal system is named AM
LPBF Thermal and the Static Structural system is named AM LPBF Structural.
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https://ansyshelp.ansys.com/Views/Secured/Doc_Assets/Static/bracket.zip


3.3. Import Geometry and Launch Mechanical

In this step, import the geometry file in Workbench and then open the Mechanical application.

1. In the Transient Thermal system, right-click Geometry and select Import Geometry.

2. Click Browse and navigate to the bracket geometry file (bracket_on_base.scdoc), select it,
and click Open to add it to the analysis. A green check mark appears next to the Geometry cell in
the Project Schematic when the geometry is added.
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3. Double-click the Model cell in the Transient Thermal system to launch the Mechanical application.
A message "Starting Mechanical" appears in the status bar in the bottom, left corner. It may take
several seconds for the application to open and attach the geometry.

4. Once Mechanical is open and you see the model, set the units for this model to millimeters. From
the Home tab in the ribbon, in the Tools group, select Units > Metric (mm, kg, N, s, mV, mA).

3.4. Load the LPBF Process Add-on and Open the LPBF Setup Wizard

1. From the Add-ons tab in the ribbon, in the Additive Manufacturing group, select LPBF Process to
load the add-on. It takes a few seconds to load.
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Load the LPBF Process Add-on and Open the LPBF Setup Wizard



2. When the LPBF Process tab appears in the ribbon, select LPBF Setup Wizard to open the wizard.

When the wizard launches, the view of the model automatically changes so that the positive Z-axis
points upward to match the build direction.

You may want to widen the application and/or wizard window to allow more space to see the wizard
options.

3.5. Complete Wizard Step 1 - Model Setup

In this step, set up the model by identifying the build and base geometries, adding the STL Support,
assigning the material, and defining the mesh criteria. A layered mesh in the positive Z direction is re-
quired in an LPBF additive simulation so that the analysis follows the build process itself: layer-by-layer
solidification of the part. See Methodology and Abstractions in the LPBF Simulation Guide for additional
information.
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1. Select the bracket body and click Apply in the Part Geometry Selection field. Note the Body picker

 is active by default.

2. Add the support:

a. In Support Action, select Add Support.

b. For Support Type, keep the default STL Supports option.

c. Click Edit in the STL Support File field, then browse to the bracket support structure file
(bracket_support_vless.stl), select it and click Open.

d. For STL Support Type, keep the default Volumeless option.

3. Select the base body and click Apply in the Base Geometry Selection field.

4. Under Material Assignment, choose AlSi10Mg as the Build Material from the drop-down menu.

5. Set mesh criteria:

a. Choose Layered Tetrahedral as the Mesh Method.

b. Specify Build Element Size = 1.25 mm, slightly larger than Mesh Layer Height. This allows
any given tetrahedral element to have a non-Z-direction edge length of up to 1.25 mm but
still maintain the 1 mm layer height in the Z-direction.

c. Specify Mesh Layer Height = 1 mm. This value is larger than recommended for the model,
but it is used in the tutorial for speed considerations. Our general guideline for a "super
layer" is to use 10-20 times the size of the machine deposition thickness.

d. Set Base Element Size = 10 mm. The base plate does not need to have as fine a mesh as
the part.

6. Click Apply Changes to update the project tree with all of our inputs.

7. Click Generate Mesh.

Important:

Be sure to click Apply Changes first before generating the mesh. This ensures the additive
bodies (part/support/base plate) are identified correctly and a layered mesh will be gen-
erated.
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To see a better view of the layered mesh, reorient the model by clicking the triad's axes arrows a
couple times to see a back or front view.
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Review the objects and options in the project tree that were created or updated when you clicked
the Apply Changes and Generate Mesh action buttons. Mesh objects, contact objects and others
have been added or changed automatically by the wizard. Review the Details of related objects to
see the wizard options you specified. Notice the Named Selections for the build body, the base
body, and sets of element faces used for contact connections. Contact connections—between the
support and the base plate (Build To Base), and between the part and its support (AM Bond)—are
created when the mesh is generated.
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Complete Wizard Step 1 - Model Setup



8. At the bottom of the wizard panel, click Next to move to the next wizard step.
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3.6. Complete Wizard Step 2 - Build Settings

In this step, we consider simulation assumptions, calibration factors, machine settings, build conditions,
and boundary conditions.

• Simulation assumptions are set by default based on the chosen AM LPBF type. In this tutorial,
we used a thermal-structural system.

• We'll use the default Thermal Strain Calibration Factor of 1. This factor scales the thermal strains
in a thermal-structural simulation and its value is determined from calibration experiments.

• Machine settings are process parameters that directly influence how the process deposits mater-
ial. We will use Ansys-supplied values for generic AlSi10Mg material.

• Build conditions are settings pertaining to the environment around the part during the deposition
process and during cooldown. This includes Preheat Temperature.

• For thermal boundary conditions, the underside of the base is typically heated to maintain a
constant, slightly elevated temperature. By default, the underside surface of the base is already
selected and a convection will be applied automatically.

• For structural boundary conditions, the underside of the base should be fixed. By default, the
underside surface of the base is already selected and the fixed support will be applied automat-
ically.

1. In the project tree (outside of the wizard), select the Build Settings object (under the AM Process
object), right-click, and choose Load Build Settings. A folder of Ansys-supplied sample files appears
by default. Select Generic_AlSi10Mg.xml and click Open.
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Complete Wizard Step 2 - Build Settings



The step just performed loads the material properties for AlSi10Mg into the project tree. Back in the
wizard, use the Read from Tree button to update the wizard panel with those same properties.

2. In the Build Settings step of the wizard, click Read from Tree.
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Immediately the properties in the wizard panel are updated to reflect those of AlSi10Mg.

3. Click Apply Changes to update the project tree with the other settings from this wizard step, includ-
ing the pre-populated face selections for the boundary conditions.

4. Click Next to move to the next wizard step.
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Complete Wizard Step 2 - Build Settings



3.7. Complete Wizard Step 3 - Postprocessing Options

In this step, select the post-build processing steps to simulate and select LPBF result items to be calcu-
lated during solution.

1. Select Base Unbolting, Base Removal, and Support Removal as the Postprocessing Steps.

2. Select Directional as the Base Removal Type, then define Removal Step Size = 10 mm and Removal
Direction = 90°. This will simulate the removal of supports in increments of 10 mm in the global Y
direction on the X-Y plane.
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3. Keep the default check boxes to calculate all LPBF Results. We will modify their settings individually
next.

4. For the Hotspot Result, select User Defined as the Threshold Definition, then define a Warning
Threshold = 135°C, which is 100° above the Preheat Temperature, and a Critical Threshold = 235°C.

5. For the Recoater Interference Result, select Layer Thickness Based as the Threshold Definition, then
define Powder Packing Density = 0.6.

6. For the High Strain Result, select User Defined as the Threshold Definition, then define a Warning
Threshold = 0.1 and a Critical Threshold = 0.2.
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Complete Wizard Step 3 - Postprocessing Options



7. Click Apply Changes to update the project tree with our selections for postprocessing steps. To
review that the steps have been added, look at the AM Process Sequence worksheet. Select the AM
Process object in the project tree, click the AM Process tab, and then select the Sequence button.
The Sequencer appears. There you can see the postprocessing steps that were added by the wizard.

8. Click Add Results. This will add the standard result items to the project tree, specifically Temperature
for the thermal system and Total Deformation, Equivalent Stress, and Equivalent Total Strain for the
structural system, and the LPBF results. Note that the Add Results action button is similar to the
Generate Mesh button in that its action is separate from the Apply Changes button. This allows the
flexibility to add multiple versions of LPBF result items if desired, perhaps with different criteria
defined for each.
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9. Click Exit Wizard.

Note:

Clicking Finish will apply all changes to all wizard steps sequentially and then close the
wizard. Since we already clicked Apply Changes in all the wizard steps, we can simply
exit the wizard.

Answer Yes to exit to the wizard start page and then click the x in the upper right corner to close
the wizard panel.
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Complete Wizard Step 3 - Postprocessing Options
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The simulation is ready to solve when you have completed the last step in the wizard, but be sure to
review the status and settings of the project tree one more time. Look for green check marks to the
left of required objects and yellow lightning bolts for items that are ready to solve. A question mark
next to an object indicates the required inputs are not complete.

3.8. Solve

1. Under the Home tab in the ribbon, find the Solve group. Set the number of CPU Cores to solve
with for this simulation, considering your computer capabilities and licensing for HPC. This example
uses 10 cores.

2. To set up a plot of overall temperature that may be updated throughout the solution, under Transient
Thermal, Solution, right-click Solution Information and select Insert > Temperature Plot Tracker.
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Solve



3. To set up a plot of overall deformation that may be updated throughout the solution, under Static
Structural, Solution, right-click Solution Information and select Insert > Deformation Plot Tracker.

4. Click the Solve lightning bolt button in the ribbon to initiate the solution. The Transient Thermal
analysis will solve first followed by the Static Structural analysis. Depending on the number of cores
specified and the machine used to run this model, the simulation may take a couple hours to com-
plete.

5. (Optional) Occasionally during the thermal solution, right-click the Temperature tracker and click
Update Result to see a live update of temperature results.
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6. (Optional) Occasionally during the structural solution, right-click the Total Deformation tracker and
click Update Result to see a live update of deformation results.
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Solve



7. Under the Result tab in the ribbon, change the display scale to 1.0 (True Scale) for a better view
of deformation. By default, the scale is set for an exaggerated display.

3.9. Review Results

Once the solve is complete, results can be viewed by clicking result items in the tree. We'll start by re-
viewing the thermal results followed by the structural results.

3.9.1.Thermal Results:Temperature and Hotspot

3.9.2. Structural Results: Deformation, Recoater Interference, and High Strain

3.9.1. Thermal Results: Temperature and Hotspot

1. Under Transient Thermal > Solution, click Temperature to view the temperature results. (Note
that the Temperature object under Solution Information shows only a snapshot of results
whereas the Temperature object under Solution shows the full thermal history when the
thermal solve is complete.)
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2. To view the result at different time steps, right-click anywhere within the time graph located
at the bottom left corner of the screen, or at any time in the tabular data at the bottom right,
and select Retrieve This Result.

Here is the result at time = 3009.6 seconds, just as a new layer is deposited. You can see the
highest temperature is 570°C, which is the melting temperature for AlSi10Mg. The layers below
the new layer had already cooled rapidly.
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Review Results



3. Use the animation controls at the top of the Graph window. Click the Result Sets button 

and the Update Contour Range at Each Animation Frame button . Adjust the number
of seconds for the animation, then click Play. See Animation in the Mechanical User's Guide
for more information about animation controls.
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The image above is an animated gif. The animation is not viewable in PDF format.

4. Under Transient Thermal > Solution, click LPBF Hotspot. This result shows the temperature
that each layer cools down to before a new layer is added. The worst hotspots are going to
be the areas with the highest temperature for that layer. This result can reveal areas of
overheating that may be of concern. Overheating can lead to poorly shaped melt pools that
can affect material properties and porosity in the part.

For this bracket, the entire part looks blue, meaning there are no hotspots to worry about
given the threshold criteria we specified. But hotspot results are localized (based on nodal
values), not averaged across the layer. We'll use a section plane to reveal any possible hotspots
inside the part.

a. Click the Home tab, then Section Plane.

b. Holding the left mouse button, draw a line anywhere through the part to create the
section plane. When you release the mouse button, the part appears cut at the plane.
Rotate the part so that you can see the interior.
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Review Results



c. In the Section Planes panel at the bottom left corner of the UI, select the newly created
section plane and click Edit Section Plane.

Drag the section plane anchor back and forth to see the inside of the part. Again,
based on our hotspot threshold criteria, there are no green or red areas, indicating
that there are no hotspots to be concerned about.
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d. Clear the check box in the Section Planes panel to see the entire part again.

3.9.2. Structural Results: Deformation, Recoater Interference, and High Strain

Now let's look at structural results.

1. Under Static Structural > Solution, click Total Deformation to view the deformation results.
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Review Results



You can zoom in on a specific subset of time steps and animate the results. Below is an an-
imation of total deformation showing just the zoomed-in results which include the last few
substeps of the cooldown step, and the base unbolting, base removal, and support removal
steps.
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The image above is an animated gif. The animation is not viewable in PDF format.

2. Under Static Structural > Solution, click LPBF Recoater Interference to view recoater inter-
ference results.

3. Under Static Structural > Solution, click LPBF High Strain to view the high strain results.
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Review Results



Congratulations! You have completed the tutorial.
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Chapter 4: DED Simulation - Racetrack
This tutorial demonstrates how to perform a Directed Energy Deposition (DED) process simulation using
the DED Process Add-on in Mechanical. The following table shows the features used.

Workbench/Mechanical

An Additive Suite license is required in addition to the license for
Mechanical.

Applicable products:

EasyLevel of difficulty:

10 minutes to set up, 55 - 60 minutes to solve, 10 minutes to review

results[a]

Interactive time required:

Directed Energy Deposition (DED)Manufacturing process:

AM DED ProcessSimulation/system type:

Inconel 718Material:

One part on planar base plateGeometry:

Cartesian elementsMesh:

Build and cooldownAM steps simulated:

DED Process Add-on, DED Setup Wizard, G-Code file defining tool path,
G-Code clustering approach

Features demonstrated:

Introduction to DED Additive ManufacturingHelp resources:

This is an approximate range. The amount of time it takes you to complete the tutorial
depends on the computer system and the number of CPU cores you use, the working pace
that is comfortable for you, and so on.

[a]

Tutorial steps:

4.1. Problem Description

4.2. Create the Analysis System

4.3. Import Geometry and Launch Mechanical

4.4. Open the DED Process Wizard

4.5.Wizard Step 1 - Identify Geometries

4.6.Wizard Step 2 - Generate Mesh

4.7.Wizard Step 3 - Set Up for Element Clustering and Create Contact Connections

4.8.Wizard Step 4 - Assign Materials

4.9.Wizard Step 5 - Define Build Settings and Thermal Boundary Conditions

4.10.Wizard Step 6 - Define Structural Boundary Conditions and Base Removal

4.11. Perform Element Clustering

4.12. Solve the Transient Thermal Analysis
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4.13. Review Thermal Results

4.14. Solve the Static Structural Analysis

4.15. Review Structural Results

4.1. Problem Description

We will simulate the DED printing process of this racetrack-shaped model, shown here on a planar
baseplate. The print direction is in the global Z-direction. A G-Code file is used to control the tool path
and we will use that for element clustering. The geometry is sliced such that there are four layers through
the height of the track.

Inputs

Inconel
718

Material

3Deposition Thickness (mm)

72Deposition Rate (mm3/s)

80Preheat Temperature (°C)

1370Process Temperature (°C)

Tutorial Files

Click here to download the following:

• DED_Racetrack.scdoc — Geometry file of the racetrack part and a base plate, saved as an
Ansys SpaceClaim document.

• DED_Racetrack_G-Code.txt — G-Code machine file that controls the build order.
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4.2. Create the Analysis System

1. Open Ansys Workbench.

2. In the toolbox on the left side of the window, scroll down to Custom Systems, expand the se-
lection, and double-click AM DED Process to bring up the linked Transient Thermal, Static
Structural system in the Project Schematic.

4.3. Import Geometry and Launch Mechanical

In this step, we import the geometry file in Workbench and then open the Mechanical application.

1. Right-click the Geometry cell in the Transient Thermal system and select Import Geometry >
Browse.

2. Navigate to the racetrack geometry file, select it, and click Open to add it to the analysis. A
green checkmark appears next to the Geometry cell in the Project Schematic when the geometry
is added.
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Import Geometry and Launch Mechanical



3. Double-click the Model cell in the Transient Thermal system to launch the Mechanical application.
A message "Starting Mechanical" appears in the status bar in the bottom, left corner. It may
take several seconds for the application to open and attach the geometry.

Release 2024 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.72

DED Simulation - Racetrack



Once the Mechanical application is open, look for a "Ready" message in the status bar.

4.4. Open the DED Process Wizard

The DED Process Add-on is loaded automatically when you use the AM DED Process custom system.

1. Click the DED Process tab at the top of the user interface to access the add-on's custom ribbon.

2. Click Open Wizard from the ribbon to open the wizards panel.
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Open the DED Process Wizard



Upon opening the wizard, the units are automatically changed to millimeters, as this unit system
is required for simulations with the DED Process Add-on.
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4.5. Wizard Step 1 - Identify Geometries

Identify which body is the part and which body is the base.

1. Select the racetrack body and click Apply in the Part Selection field. (Note the Body picker 
is active by default.)

2. Select the base body and click Apply in the Base Selection field.

3. Click Next to move to the next step.
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Wizard Step 1 - Identify Geometries



When this step is completed, Named Selections for the part body (print_part) and base body (base_plate)
have been added to the Project tree. These will be used later for the creation of other Named Selections.
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4.6. Wizard Step 2 - Generate Mesh

Because this is a simple geometry, we will mesh the part with Cartesian elements. We will use an element
size of 3 mm for the part to match the deposition thickness. Reviewing the G-Code file below shows
the first layer has a Z-coordinate of 3.0, the second layer's Z-coordinate is 6.0, and so on. This will result
in 4 layers through the height of the model. We will mesh the base with standard brick elements with
a slightly larger element size of 4 mm.

G00 X-100.0 Y-83.5 Z0.0
; First layer
G00 X-54.0 Y-83.5 Z3.0
G01 X-49.9 Y-104.2 ; Circle 1
G01 X-38.2 Y-121.7
G01 X-20.7 Y-133.4
G01 X0.0 Y-137.5
G01 X20.7 Y-133.4
G01 X38.2 Y-121.7
G01 X49.9 Y-104.2
G01 X54.0 Y-83.5
G01 X54.0 Y80.2 ; Y-Line 1
G01 X49.9 Y100.9 ; Circle 2
G01 X38.2 Y118.4
G01 X20.7 Y130.1
G01 X0.0 Y134.2
G01 X-20.7 Y130.1
G01 X-38.2 Y118.4
G01 X-49.9 Y100.9
G01 X-54.0 Y80.2
G01 X-54.0 Y-83.5 ; Y-Line 2
G00 X-54.0 Y-64.6
G01 X54.0 Y-64.6 ; X-Line 1
G00 X-54.0 Y63.4
G01 X54.0 Y63.4 ; X-Line 2
; Next layer
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G00 X-54.0 Y-83.5 Z6.0
G01 X-49.9 Y-104.2 ; Circle 1
G01 X-38.2 Y-121.7
G01 X-20.7 Y-133.4
G01 X0.0 Y-137.5
G01 X20.7 Y-133.4
G01 X38.2 Y-121.7
G01 X49.9 Y-104.2
G01 X54.0 Y-83.5
G01 X54.0 Y80.2 ; Y-Line 1
G01 X49.9 Y100.9 ; Circle 2
G01 X38.2 Y118.4
G01 X20.7 Y130.1
G01 X0.0 Y134.2
G01 X-20.7 Y130.1
G01 X-38.2 Y118.4
G01 X-49.9 Y100.9
G01 X-54.0 Y80.2
G01 X-54.0 Y-83.5 ; Y-Line 2
G00 X-54.0 Y-64.6
G01 X54.0 Y-64.6 ; X-Line 1
G00 X-54.0 Y63.4
G01 X54.0 Y63.4 ; X-Line 2
; Next layer
G00 X-54.0 Y-83.5 Z9.0
G01 X-49.9 Y-104.2 ; Circle 1
G01 X-38.2 Y-121.7
G01 X-20.7 Y-133.4
G01 X0.0 Y-137.5
G01 X20.7 Y-133.4
G01 X38.2 Y-121.7
G01 X49.9 Y-104.2
G01 X54.0 Y-83.5
G01 X54.0 Y80.2 ; Y-Line 1
G01 X49.9 Y100.9 ; Circle 2
G01 X38.2 Y118.4
G01 X20.7 Y130.1
G01 X0.0 Y134.2
G01 X-20.7 Y130.1
G01 X-38.2 Y118.4
G01 X-49.9 Y100.9
G01 X-54.0 Y80.2
G01 X-54.0 Y-83.5 ; Y-Line 2
G00 X-54.0 Y-64.6
G01 X54.0 Y-64.6 ; X-Line 1
G00 X-54.0 Y63.4
G01 X54.0 Y63.4 ; X-Line 2
; Next layer
G00 X-54.0 Y-83.5 Z12.0
G01 X-49.9 Y-104.2 ; Circle 1
G01 X-38.2 Y-121.7
G01 X-20.7 Y-133.4
G01 X0.0 Y-137.5
G01 X20.7 Y-133.4
G01 X38.2 Y-121.7
G01 X49.9 Y-104.2
G01 X54.0 Y-83.5
G01 X54.0 Y80.2 ; Y-Line 1
G01 X49.9 Y100.9 ; Circle 2
G01 X38.2 Y118.4
G01 X20.7 Y130.1
G01 X0.0 Y134.2
G01 X-20.7 Y130.1
G01 X-38.2 Y118.4
G01 X-49.9 Y100.9
G01 X-54.0 Y80.2
G01 X-54.0 Y-83.5 ; Y-Line 2
G00 X-54.0 Y-64.6
G01 X54.0 Y-64.6 ; X-Line 1
G00 X-54.0 Y63.4
G01 X54.0 Y63.4 ; X-Line 2
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1. Choose Cartesian for Mesh Type.

2. Enter 3 for Build Element Size.

Keep 0 (default) for Projection Factor.

3. Enter 4 for Base Element Size.

4. Click Next to move to the next step.

When this step is completed, mesh objects have been added to the Project tree: Body Fitted Cartesian
object for the part and Body Sizing for the base plate.
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Wizard Step 2 - Generate Mesh



The resulting mesh is shown here.
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See the following topics in the DED Simulation Guide for additional information:

• Apply Mesh Controls and Generate Mesh

4.7. Wizard Step 3 - Set Up for Element Clustering and Create Contact
Connections

In this step, we will set up for element clustering. Note that the actual generation of element clusters
is not performed in the wizard; we will generate clusters after we finish the wizard.

Also in this step, the contact connection between the part and the base plate is made automatically.
Connections ensure that the part and base bodies in the simulation are aware of each other and are
able to share data (temperatures and displacements) across boundaries.

1. Choose G-Code Clustering for Input Source because we have a G-Code file defining the tool
path.

2. Click Edit and browse to the DED_Racetrack_G-Code.txt file. Click Open.

3. Enter 1000 for Cluster Volume. This value determines how many elements are activated per
load step. The time for this load step is then determined by volume/deposition rate. A smaller
cluster volume tends to provide a more accurate result. Based on the overall dimension of the
build geometry, this value should be determined by balancing the computational cost and
desired accuracy.

Keep Z (default) for Print Direction.

Keep Yes (default) for Build to Base Contact Generation.

Keep Auto (default) for Contact Generation Method. This assumes a planar baseplate, which
we have for this model.
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Wizard Step 3 - Set Up for Element Clustering and Create Contact Connections



4. Click Next to move to the next step.

In this step, the AM Process for DED object and its child objects are added to the project tree. AM Process
for DED establishes the options and assumptions appropriate for a DED simulation.
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Wizard Step 3 - Set Up for Element Clustering and Create Contact Connections



Also, two new Named Selections have been added defining the element faces required for contact
generation. Finally, a DED_Contact object has been added to establish the contact connection between
the part and the base plate. It uses the element faces Named Selections.
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See the following topics in the DED Simulation Guide for additional information:
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• Perform Element Clustering

• Define Connections

4.8. Wizard Step 4 - Assign Materials

Assign the AM material Inconel 718 to both bodies.

1. Choose Engineering Data for Material Assignment.

2. Choose Inconel 718 for the Build Material.

3. Choose Inconel 718 for the Base Material.

4. Click Next to move to the next step.

In this step, Inconel 718 material is assigned to both the part and the base plate. The Reference Tem-
perature is set to By Environment for now but the Reference Temperature for the part will be updated
in the Build Settings step next.
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See the following topics in the DED Simulation Guide for additional information:

• Assign Materials

4.9. Wizard Step 5 - Define Build Settings and Thermal Boundary Condi-
tions

Specify settings and conditions related to the DED machine and the process. We will use many of the
defaults, such as values for gas convection coefficients, advanced options, and so on. Use the links to
the DED Simulation Guide provided at the end of this section for more information about these options.

Machine Settings:
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1. Enter 72 for Material Deposition Rate. The value should match the actual machine setting for
the printing process.

Build Conditions:

2. Enter 80 for Preheat Temperature. This is determined by the actual preheating condition of the
printing process.

3. We apply the preheat to the bottom surface of the base plate. Rotate the model in the graphics
window, select the underside surface of the base, and click Apply in the Preheat Geometry
field. We will keep the preheat off during printing.

4. Enter 1370 for Process Temperature. This is the temperature value assigned to newly activated
elements at each load step, normally set as the melting temperature.

Cooldown Conditions:

5. Enter 3600 for Time. This allows an hour for cooldown.

Keep Yes (default) for Add Temperature Result. This is simply a convenience option related to
the simulation and not related to anything in the printing process. A value of Yes adds a result
item object into the project tree before solution so that the calculated temperatures will be
populated upon solution completion and viewable with one click.

6. Click Next to move to the next step.

In this step, the Build Settings object is populated with chosen settings. The green checkmark next to
the Build Settings object indicates it is now complete. Also, a Temperature result item is added under
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the Transient Thermal Solution object. Finally, the part body is assigned a Reference Temperature By
Body and the Reference Temperature Value is set to the Process Temperature. This is an important update
to the properties for the part.

See the following topics in the DED Simulation Guide for additional information:

• Define Build Settings
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• Apply Thermal Boundary Conditions

4.10. Wizard Step 6 - Define Structural Boundary Conditions and Base
Removal

Here we will apply a fixed support to the underside of the base plate. We will not simulate removal of
the base plate for this example.

1. Select the underside surface of the base, and click Apply in the Geometry Selection field.

2. Choose No for Base Removal.

Keep Yes (default) for Add Deformation Result. This is simply a convenience option related to
the simulation and not related to anything in the printing process. A value of Yes adds a result
item object into the project tree before solution so that the calculated displacements will be
populated upon solution completion and viewable with one click.

3. Click Finish to complete the wizard.

4. Click X in the upper, right corner to close the wizard panel.

Release 2024 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.90

DED Simulation - Racetrack



Upon completion of the wizard, a Fixed Support object has been added to the project tree, along with
a Total Deformation result item under the Static Structural Solution object.

When completing any wizard, you should review the status icons next to each object in the project
tree. Objects with green checkmarks are complete. Objects with yellow lightning bolts indicate an action
is required, such as mesh, generate, or solve. For this tutorial, the yellow lightning bolt next to G-Code
Clustering indicates we now need to generate element clusters.

See the following topics in the DED Simulation Guide for additional information:

• Apply Structural Boundary Conditions
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4.11. Perform Element Clustering

In the wizard, we identified the G-Code machine file. We should view and verify the tool path defined
in the G-Code file before generating the element clusters.

1. Click the DED Process toolbar.

2. Click Show Path. Blue lines represent the tool path with no material deposition and green lines
represent the tool path with material deposition. Visualization helps to determine the following:

• Is it the correct G-Code file?

• Is the location / rotation / orientation of the path correct with respect to the model?

• Are the unit systems of the G-Code file and model matching?

• Do I need to apply a Layer Offset to place the path on top of the layers?

• Did I set the correct Laser On / Off commands?

3. Click the Hide Path button to turn off the tool path display.
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Once we have confirmed the path looks correct, we simply need to generate the element clusters.

Important:

The cluster generation step requires an Ansys Additive Suite software license with Ansys
Mechanical Enterprise or one of the multiphysics bundles. If you get a warning message at
this step, check your software license.

4. Under the AM Process for DED object, right-click G-Code Clustering and select Generate.

The clustering process may take a few to several minutes, depending on the size of your model. When
completed, you will see Named Selections for all the clusters organized into folders, one folder per

layer. Given the part geometry, the Build Element Size of 3 mm, and the Cluster Volume of 1000 mm3,
there are 76 total clusters for this model. The following image shows one example cluster consisting of
37 elements on layer 4.
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Perform Element Clustering



You can view the progression of element clusters along the path.

5. Under Named Selections, expand the Layer 1 folder and click the first cluster, el_loop_01 to
see the first element cluster.

6. Click the Cluster Selection Forward button in the toolbar to show the next cluster. Continue
clicking the Cluster Selection Forward button to see consecutive clusters displayed along the
tool path.
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Once the element clusters are generated, a green checkmark appears next to the AM Process for DED
object. Our simulation is ready to be solved.

See the following topics in the DED Simulation Guide for additional information:

• Perform Element Clustering

4.12. Solve the Transient Thermal Analysis

We will solve the Transient Thermal system first and view results before proceeding to the Static
Structural solution. First we should set the number of cores we want to use.

1. Click the Home tab in the ribbon.

2. In the Solve group, set the number of Cores to solve with for this simulation, considering your ma-
chine capabilities and licensing for HPC. This example uses 8 cores.

3. Right-click the Transient Thermal object and select Solve.
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Solve the Transient Thermal Analysis



It is safe to ignore the warning message: "The model has no temperature, convection, or radiation
conditions specified...", as the DED Process Add-on applies the appropriate boundary conditions
automatically with information from the wizard.

4.13. Review Thermal Results

1. When the thermal solution is finished, click the Temperature result object under Transient Thermal
> Solution to see a plot of overall temperatures at the end of cooldown.
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2. Right-click anywhere within the temperature-time graph located at the bottom, left corner of the
screen, or at any time in the tabular data at the bottom right, and choose Retrieve This Result to
see temperatures at that time point.

97
Release 2024 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Review Thermal Results



Here is the result at time=430.37 seconds.
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3. Use the animation controls at the top of the Graph window. Click the Result Sets button  and

also the Update Contour Range at Each Animation Frame button . Adjust the number of
seconds for the animation and click Play. See Animation in the Mechanical User's Guide for more
information about animation controls.

The following is an animated gif. Refresh the page to refresh the animation. The animation is not viewable
in PDF format.

4.14. Solve the Static Structural Analysis

1. Right-click the Static Structural object and select Solve.
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Solve the Static Structural Analysis



4.15. Review Structural Results

1. When the structural solution is finished, click the Total Deformation result object under Static
Structural > Solution to see a plot of overall displacements at the end of cooldown.

2. Change the display scale to 1.0 (True Scale) in the ribbon (Result tab) for a better view of
deformation. (By default, the scale is set for an exaggerated display.)
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3. To view different time steps, right-click different steps in tabular data or on the results graph
and select Retrieve This Result.

Just as we viewed an animation of thermal results, we can view an animation of the structural
results. The following is an animated gif. Refresh the page to refresh the animation. The animation
is not viewable in PDF format.

Congratulations! You have completed the tutorial.
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Chapter 5: Sintering Simulation - Printed Bridge
This tutorial demonstrates how to perform a sintering process simulation using the Sintering Process
Add-on in Mechanical.

The following features and capabilities are used:

• Sintering Process Wizard (included with the add-on)

• Ansys-predefined sintering material 316L (PIM)

• Sintering result items: Relative Density and Sinter Stress

Tutorial steps:

5.1. Problem Description

5.2. Create Analysis System

5.3. Attach Geometry and Set Units

5.4. Load Sintering Process Add-on

5.5.Wizard Step 1 - Identify Geometries

5.6.Wizard Step 2 - Define Contact

5.7.Wizard Step 3 - Define Constraints

5.8.Wizard Step 4 - Generate Mesh

5.9.Wizard Step 5 - Define Gravity

5.10.Wizard Step 6 - Define Sinter Material

5.11.Wizard Step 7 - Define Sinter Schedule

5.12.Wizard Step 8 - Define Results and Solver Settings

5.13. Generate Sinter Schedule and Solve

5.14. Review Results

5.1. Problem Description

We will simulate the sintering process of this span bridge model, shown here on a planar baseplate.
The model is composed of 316L stainless steel in a green state after it has been printed. Our simulation
goals are to examine the densification during sintering and the final shape after shrinkage.
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The sintering process is performed in a single heating cycle in a batch furnace. For simplicity, the process
has one short isothermal hold, as shown here:

105
Release 2024 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Problem Description



Tutorial Files

Click here to download the following:

bridge_with_base.scdoc — Geometry file of the span bridge part and a base plate, saved as an
Ansys SpaceClaim document.

5.2. Create Analysis System

1. Open Ansys Workbench.

2. In Workbench, from the Analysis Systems listed on the left, drag a Static Structural analysis into
the Project Schematic.
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5.3. Attach Geometry and Set Units

In this step, we attach the geometry file in Workbench and then open the Mechanical application. Once
in Mechanical, the first thing we will do is set units.

1. Right-click the Geometry cell in the Static Structural system and select Import Geometry >
Browse.

2. Navigate to the bridge with baseplate geometry file, select it, and click Open to add it to the
analysis. A green check mark appears next to the Geometry cell in the Project Schematic when
the geometry is added.

107
Release 2024 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Attach Geometry and Set Units



3. Double-click the Model cell to launch the Mechanical application. A message "Starting Mechan-
ical" will show up in the status bar in the bottom, left corner. It may take a couple minutes for
the application to open and attach the geometry.

Release 2024 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.108

Sintering Simulation - Printed Bridge



4. Once the Mechanical application is open and you see a "Ready" message in the status bar, click
the Home tab. Select Units from the ribbon and then select Metric (mm, t, N, s, mV, mA).
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5.4. Load Sintering Process Add-on

This step includes the loading of the Sintering Process Add-on and opening of the Sintering Process
Wizard.

1. Click the Add-ons tab in the ribbon.

2. In the Additive Manufacturing group, click Sintering Process to load the add-on.
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3. Click the Sintering Process tab in the ribbon.

4. Click Open Wizard from the ribbon.
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5.5. Wizard Step 1 - Identify Geometries

Identify which body is the green part and which body is the base.

1. Use the Body picker  to select the bridge body and click Apply in the Geometry field under
Part.

2. Click Yes in the Baseplate field because this model has a baseplate.
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3. Select the base body and click Apply in the Geometry field under Baseplate.

4. Click Next to move to the next step.

When this step is completed, Named Selections for the part body (Part) and base body (Baseplate) have
been added to the Project tree. These will be used later for the creation of other Named Selections.
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5.6. Wizard Step 2 - Define Contact

Contact between the part and baseplate is automatically detected by default in Mechanical because
the bodies touch one another (they are mutually tangent). The wizard lets you use this automatically
detected contact region, which is indicated by a specific contact region ID number, or you can specify
a new contact region or skip the step and define contact later. We will use the automatically detected
contact region.

1. Choose Contact Region ( Id = 29 ) for Selected Contact Region.
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2. We will use the recommended default settings for the contact interface between the part and
the baseplate. The baseplate is large and stiff enough that we can ignore flexibility and assume
a rigid baseplate. This assumption speeds up the simulation time. We expect the part to slide
on the base as the part shrinks during sintering so we will be sure Small Sliding option is off.

Keep 0.2 (default) for Friction Coefficient.

3. Keep Yes (default) for Rigid Baseplate.

4. Keep Off (default) for Small Sliding.

5. Keep Each Iteration (Aggressive) (default) for Update Stiffness.

6. Keep Yes (default) for Adjust To Touch.

When this step is completed, a Contact Region object has been added to the Project tree.
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5.7. Wizard Step 3 - Define Constraints

In this step we'll apply a fixed support to the underside of the base plate.

1. Click Fixed Support in the Constraint Type field.
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2. Rotate the model in the graphics window, use the Face picker  to select the underside surface
of the base, and click Apply in the Geometry field.

3. Click Next to move to the next step.

When applied to a rigid body, a body-to-ground fixed joint will be created instead of the Fixed Support
boundary condition, as shown in the Project tree.
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5.8. Wizard Step 4 - Generate Mesh

We'll specify a mesh size of 1 mm so that there are at least three elements through the height of the
bridge span.

1. Keep Yes (default) for Mesh via Wizard.

2. Enter 1 for Element Size.

3. Keep Yes (default) for Contact Sizing (recommended).
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4. Click Next to move onto the next step.

When this step is completed, mesh objects have been added to the Project tree: a Body Sizing object
for the part and baseplate, and Contact Sizing for improved contact traction. The resulting mesh is
shown here.
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5.9. Wizard Step 5 - Define Gravity

A gravitational acceleration is applied so that frictional forces between the bridge and the baseplate
prevent rigid body motion.

1. Keep -Z (default) for Gravity Direction.

2. Click Next to move to the next step.

A Standard Earth Gravity object has been added to the Project tree.
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5.10. Wizard Step 6 - Define Sinter Material

Use an Ansys-defined sinter material or a user-defined one. We'll use stainless steel 316L (PIM) from our
library. See Sintering in the Material Reference for more information.

1. Choose 316L (PIM) for Material.

2. Choose Type 1 for Pre-defined Models.

3. Keep 0.5 (default) for Initial Relative Density. This value—50% dense—will be uniformly applied
to the entire part.

4. Keep 0.025 (default) for Mean Powder Diameter. This is the average powder diameter used for
building of the part.

5. Enter 1000 for Sinter Activation Temperature. This is the temperature above which sintering
stress is non-zero and shrinkage can occur.

6. Click Next to move to the next step.
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Wizard Step 6 - Define Sinter Material



When this step is completed, a Sinter Material object has been added in the Project tree with the required
coefficients and exponents and other material model inputs populated based upon the model type
selected in the wizard.
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5.11. Wizard Step 7 - Define Sinter Schedule

The sintering furnace schedule is defined in this step. As shown in the problem description (p. 103), the
temperature ramps up to 1380°C in two hours and holds at that temperature for one more hour.

1. Keep 22 (default) for Room Temperature.

2. Click Add, and enter 1380 and 7200 for Temperature [C] and Time/Duration, respectively.
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3. Click Add to insert a second row, and enter 1380 and 3600 for Temperature [C] and
Time/Duration, respectively.

4. Click Next to move to the next step.

When this step is completed, a Sinter Schedule object has been added in the Project tree. The yellow
lightening bolt next to the object indicates that there is an action required, which is the generation of
the sinter schedule itself. We will do this after completing the wizard.
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5.12. Wizard Step 8 - Define Results and Solver Settings

The final wizard step allows us to customize results and solver settings. We will use the recommended
defaults.

1. Keep Yes (default) for Generate Result Objects.

2. Keep Yes (default) for Large Deflection.

3. Keep Yes (default) for Quasi-Static Solution.
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4. Keep Yes (default) for Auto Time Stepping, 1 (default) for Min Time Step, and 1000 (default)
for Max Time Step.

5. Click Finish to complete the wizard.

6. Click X in the upper, right corner to close the wizard panel.

When this step is completed, several sintering-specific result items have been added in the Project tree.
We will review those items once the solution is complete.
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5.13. Generate Sinter Schedule and Solve

An optional step is to generate the sintering schedule before solving, perhaps to verify that the data
is correct. Otherwise, generation of the schedule is done automatically when the solution is initiated.

1. Under the Static Structural analysis, right-click Sinter Schedule and select Generate.
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After a few seconds, a plot and table representing the sinter schedule appears below the
graphics window. Note that a very small, insignificant step (1 second) is added at both the be-
ginning and end of the furnace schedule to aid in simulation convergence.

2. We are now ready to solve! Under the Static Structural analysis, right-click Solution (A6) and
select Solve to initiate the solution.

3. While the solution is solving, right-click Solution Information, click Insert, and select Deform-
ation Plot Tracker to see the deformation during solution.
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4. Occasionally during the solution, right-click the Total Deformation plot tracker and select
Update Result to get a fresh snapshot of the deformation.
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5.14. Review Results

Once the solution is complete, review results by clicking on the result items in the tree.

1. First, change the display scale to 1.0 (True Scale) in the ribbon (Result tab) for a better view
of deformation. (By default, the scale is set for an exaggerated display.)

2. Next click Total Deformation. The result shows bending in the middle of the bridge span due
to gravity because of the viscoplasticity of the material. View the behavior over time in the
graph below the graphics window. There is an initial thermal expansion followed by shrinkage
once the sintering activation temperature is reached.

3. Use the animation controls to see an animated display of the deformation, as shown here. The
following is an animated gif. Refresh the page to refresh the animation. The animation is not viewable
in PDF format.
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4. Click Relative Density. A maximum densification of 0.566, or about 56%, occurs at the top of
the bridge span where compression of the material aids densification. The bottom of the span
experiences tension and, therefore, less densification.
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5. Click Sinter Stress. Sinter stress is the driving force that cause shrinkage. Once the temperature
reaches the sintering activation temperature, the stress abruptly increases.

Congratulations! You have completed the tutorial.
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